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1.  Introduction 
With this introductory example, we would like to make you acquainted with the most impor-
tant features of RSTAB. Often you have several options to achieve your targets. Depending on 
the situation and your preferences you can play with the software to learn more about the 
possibilities of the program. With this simple example we want to encourage you to find out 
useful functions in RSTAB. 

We will model a planar two-hinged frame and the loads. Then we design the model according 
to nonlinear second-order analysis with regard to the following load cases: self-weight, snow, 
wind and imperfection. 

As superimposing actions according to EN 1990 involves considerable time and effort, we will 
use the generator for load combinations already integrated in RSTAB 8. 

With the 30-day trial version, you can work on the model without any restriction. Even after the 
expiry of the 30-day period, you can enter an example and calculate it; however, saving your 
results is no longer possible. 

It is easier to enter data if you use two screens, or you may print the description to avoid 
switching between the displays of PDF file and RSTAB input. 

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog boxes, 
tables and menus are set in italics to clarify the explanations. Input required is written in bold 
letters. 

You can look up the description of program functions in the RSTAB manual that you can 
download on the Dlubal website at http://www.dlubal.com/Downloading-Manuals.aspx. 

The file RSTAB-Example-06.rs8 containing all model data of the following example can be 
found in the Examples project that has been created automatically during the installation. 
However, for the first steps with RSTAB we recommend you to enter the model manually.  
If you do not have the time for it, you can watch the videos on our website at 
www.dlubal.com/videos-from-category-videos-for-rstab.aspx. 

 

 

http://www.dlubal.com/Downloading-Manuals.aspx
http://www.dlubal.com/videos-from-category-videos-for-rstab.aspx
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2.  System and Loads 
 

2.1 Sketch of System 
In our example we analyze the steel frame of a hall that is reinforced by haunches. 
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Figure 2.1: System and loading  

2.2 Materials and Cross-sections  
We use the standard steel S 235. 

Both columns consist of cross-sections of the type HE-A 300. The horizontal beams are cross-
sections of the type IPE 360. 

The taper is made of a metal sheet reinforcement with a thickness of 10 mm, reaching a height 
of 300 mm on the column connection. 
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2.3 Load 

Load case 1: self-weight and finishes 
As load, the framework's self-weight (steel cross-sections) is to be considered that RSTAB de-
termines automatically from the cross-section properties. 

In addition, the hall's roof structure is applied with 0.3 kN/m2. For a frame distance of 5 m, the 
load is: 

q = 0.3 kN/m2 * 5 m = 1.5 kN/m 

There are no wall loads transferred by the columns. 

Load case 2: snow 
For the hall we apply snow load zone 2 in Germany and an altitude of 200 m. According to  
EN 1991-1-3, we have to apply the characteristic value sk = 0.85 kN/m2. Together with the 
shape coefficient α = 0.8 for the roof inclination of 5.7° we get a snow load of: 

q = 0.8 * 0.85 kN/m2 * 5 m = 3.4 kN/m 

Load case 3: wind 
To simplify our example, we apply the wind loads of wind zone 1 and terrain category III on  
the columns only, neglecting the roof areas. The wind loads are determined according to  
EN 1991-1-4 and the national annex (NA) for Germany with the simplified velocity pressure  
qp = 0.5 kN/m2. So we get the following wind pressure on the upwind side: 

wD = 0.8 * 0.5 kN/m2 * 5 m = 2.0 kN/m 

For the downwind side we have the following suction load: 

wS = 0.5 * 0.5 kN/m2 * 5 m = 1.25 kN/m 

Load case 4: imperfection 
Often imperfections must be considered, for example according to Eurocode 3. Inclinations 
and precambers are managed in a separate load case. So it is possible to assign specific partial 
safety factors when you combine the load with other actions. 

For the column cross-sections (HE A 300) we assume the buckling curve c (displacement in di-
rection of z-axis) according to EN 1993-1-1, Table 6.2. The inclinations ϕ0 and precambers e0,d 
are determined according to EN 1993-1-1, Clause 5.3.2 as follows: 

Inclination ϕ0 = 1/200 

Precamber e0,d = L/200 

As the buckling curve b is valid for IPE 360 cross-sections, we can apply a smaller precamber of 
e0,d = L/250 for the horizontal beams. For the beam, no inclination is assigned.  
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3.  Creation of Model 
 

3.1 Starting RSTAB 
To start RSTAB in the taskbar, we 

click Start, point to All Programs and Dlubal, and then we select Dlubal RSTAB 8.xx, 

or we double-click the icon Dlubal RSTAB 8.xx on the computer desktop. 

3.2 Creating the Model 
The RSTAB work window opens showing us the dialog box below. We are asked to enter the 
basic data for the new model. 

If RSTAB already displays a model, we close it by clicking Close on the File menu. Then, we 
open the General Data dialog box by clicking New on the File menu. 

 
Figure 3.1: Dialog box New Model - General Data 

We write Introductory Example into the input field Model Name. To the right, we enter Hall 
frame as Description. We always have to define a Model Name because it determines the name 
of the RSTAB file. The Description field does not necessarily need to be filled in. 

In the input field Project Name, we select Examples from the list if not already set by default. 
The project Description and the corresponding Folder are displayed automatically. 

In the dialog section Type of Model, we select the option 2D - in XZ because we want to model  
a planar framework. It is always possible to extend the model to a 3D framework structure later. 

We keep the default setting Downward for The Positive Orientation of Global Axis Z. 
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In the dialog section Classification of Load Cases and Combinations, we select the entry EN 1990 
from the list According to Standard. We don't change the setting CEN in the field National annex 
to the right. This specification is important when we combine actions with partial safety factors 
and combination coefficients conforming to standards. 

Then, we tick the check box Create combinations automatically. We want to superimpose the 
actions in Load combinations. 

Now, the general data for the model is defined. We close the dialog box by clicking the [OK] 
button. 

The empty work window of RSTAB is displayed. 

4.  Model Data 
 

4.1 Adjust Work Window and Grid 

View 
First, we click the [Maximize] button on the title bar to enlarge the work window. We see the 
axes of coordinates with the global directions X, Y and Z displayed in the workspace. 

To change the position of the axes of coordinates, we click the button [Move, Zoom, Rotate] in 
the toolbar above. The pointer turns into a hand. Now, we can position the workspace accord-
ing to our preferences by moving the pointer and holding the left mouse button down. For en-
tering data we recommend to shift the axes of coordinates to the left in direction of the navi-
gator. 

Furthermore, we can use the hand to zoom or rotate the view: 

• Zoom: We move the pointer and hold the [Shift] key down. 

• Rotation: We move the pointer and hold the [Ctrl] key down. 

To exit the function, different ways are possible: 

• We click the button once again. 

• We press the [Esc] key on the keyboard. 

• We right-click into the workspace. 

Mouse functions 
The mouse functions follow the general standards for Windows applications. To select an ob-
ject for further editing, we click it once with the left mouse button.  We double-click the object 
when we want to open its dialog box for editing. 

When we click an object with the right mouse button, its context menu appears showing us 
object-related commands and functions. 

To change the size of the displayed model, we use the wheel button of the mouse. By holding 
down the wheel button we can shift the model directly. When we press the [Ctrl] key addition-
ally, we can rotate the structure. Rotating the structure is also possible by using the wheel but-
ton and holding down the right mouse button at the same time. The pointer symbols shown 
on the left show the selected function. 
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Grid 
The grid forms the background of the workspace. In the dialog box Work Plane and Grid/Snap, 
we can adjust the spacing of grid points. To open the dialog box, we use the button [Settings 
of Work Plane]. 

 
Figure 4.1: Dialog box Work Plane and Grid/Snap 

Later, for entering data in grid points, it is important that the control fields SNAP and GRID  
in the status bar are set active. In this way, the grid becomes visible and the points will be 
snapped on the grid when clicking. 

Work plane 
The XZ plane is preset as work plane. With this setting all graphically entered objects will be 
generated in the vertical plane. The plane has no significance for the data input in dialog box-
es or tables. 

The default settings are appropriate for our example. We close the dialog box with the [OK] 
button and start with the model input. 
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4.2 Creating Members 
It would be possible to define the nodes graphically or in the table to connect them with 
members subsequently. But in our example we use the direct graphical input of members. 

4.2.1 Columns 
Before we can set a member in the work window, we have to define its properties. To open the 
corresponding dialog box, 

we click Model Data on the Insert menu, then we point to 1.7 Members and Graphically, 
and then we select Single, 

or we use the corresponding button in the toolbar, which is the quicker way of selecting the 
function. 

The dialog box New Member opens. 

 
Figure 4.2: Dialog box New Member 

The Member No. 1 and the Member Type Beam are already preset. It is not necessary to change 
these settings. 

Defining a cross-section 
In the dialog section Cross-Section, we click the button [New] to assign a stiffness for material 
and cross-section to the Member start. The dialog box New Cross-Section appears (see Figure 
4.3 in background). 

As the columns consist of rolled cross-sections, we click the button [HE-A] in the dialog box. 
The dialog box Rolled Cross-Sections - I-Sections appears where we select the cross-section  
HE A 300. 
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Figure 4.3: Selecting HE A 300 in the library 

To check the properties of the cross-section, we can use the [Info] button. 

We close the dialog box Rolled Cross-Sections - I-Sections to import the cross-section properties 
to the dialog box New Cross-Section. As our framework is a 2D model, only relevant input fields 
are filled with data in this dialog box. 

For rolled cross-sections RSTAB presets the Material with number 1 - Steel S 235 according to 
EN 10025-2. When we want to use a different material, we can select another one by means of 
the [Material Library] button. 

 
Figure 4.4: Dialog box New Cross-Section 

In the Comment field, we can enter Columns to specify the cross-section. 
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We close the dialog box by clicking [OK] and return to the initial dialog box New Member. 

 
Figure 4.5: Dialog box New Member 

When we have checked the input fields, we close the dialog box with the [OK] button. Now we 
can set the column members. 

Placing members 
Members can be set directly by clicking grid points or nodes. If the start or end points of the 
member do not lie within the grid that has been set, we can enter the coordinates in the float-
ing dialog box New Member manually. Please take care not to move with the pointer outside 
the dialog window, otherwise its coordinates are considered again for the input. Furthermore, 
we can switch between the input fields by using the mouse or the [Tab] key on our keyboard. 
Instead of clicking the [Apply] button used to set a node, we can also use the [Enter] key. 

 
Figure 4.6: Defining columns graphically 

We define the support node of the first column by a single click with the left mouse button in-
to the coordinate origin (X/Y/Z coordinates 0.000/0.000/0.000). The current pointer coordi-
nates are displayed next to the reticle. 

The top end of the column is set into the grid point 0.000/0.000/-5.000. 
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We continue our input and define member 2 by clicking the grid points 20.000/0.000/0.000 
for the footing of the column and 20.000/0.000/-5.000 for the head. 

When the grid points lie outside the workspace, we can zoom out the view by using the wheel 
button of the mouse. It is also possible to shift the view slightly to the left by holding down the 
wheel button (see also chapter 4.1, page 8). The command for placing members will not be af-
fected. 

For now we stop setting other members. We quit the input mode by pressing the [Esc] key.  
We can also use the right mouse button to right-click in an empty area of the work window. 

Show numbering 
If we want to display the numbering of nodes and members, we right-click into an empty 
space of the work window. A context menu with useful functions appears. We activate the 
Numbering. 

 
Figure 4.7: Show numbering in context menu 

We can use the Display tab in the navigator to control the numbering of objects in detail. 

 
Figure 4.8: Display navigator for numbering 
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4.2.2 Horizontal Beams 
Placing members 

As the horizontal beams are connected to each other, we can define them as a polygonal chain. 
To open the corresponding dialog box, 

we click Model Data on the Insert menu, then we point to 1.7 Members and Graphically, 
and then we select Continuous, 

or we use the corresponding button in the toolbar shown on the left. 

The dialog box New Member opens again. We create a [New] cross-section as cross-section 
number 2 and select an IPE 360 section from the IPE cross-section table. 

 
Figure 4.9: Dialog box New Member 

 
Figure 4.10: Selecting IPE 360 in the library 
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When we have confirmed all dialog boxes, we set the first horizontal beam by clicking the fol-
lowing points: We start with node 2 (0.000/0.000/-5.000) that is already defined. Then, we set 
the member end into the grid point 10.000/0.000/-6.000 (node of ridge). Finally, we click 
node 4 (20.000/0.000/-5.000) to finish the input. 

By clicking these three points RSTAB creates the members 3 and 4. We quit the input mode by 
pressing the [Esc] button twice. We can also right-click two times into in an empty space of the 
work window. 

 
Figure 4.11: Horizontal beams 3 and 4 

Dividing members 
The entered model does not yet correspond completely to the specified system. The reinforce-
ments for the frame joints are still missing. 

First, we divide the horizontal beams by intermediate nodes to define the reinforcement 
zones. We click the left beam with the right mouse button. The member context menu opens 
where we select Divide Member by Distance. 

 
Figure 4.12: Context menu of member 
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In the dialog box Divide Member Using Distance, we change the reference of the distance to 
Projection in direction X. Then, we enter the value 2.40 m (length of taper) into the input 
field Distance Between New Node and Member start. 

 
Figure 4.13: Dialog box Divide Member Using Distance 

When confirming with [OK], RSTAB divides the left horizontal beam. Member 5 is created. 

Now, we divide the right beam in the same way. This time we define the distance of 2.40 m for 
the Member end. 

Defining reinforcements for horizontal beams 
We create the beam reinforcement with a gusset. We define two new cross-sections and assign 
them to the members. In this way, we can model a taper: The cross-section depth of the mem-
ber is changing linearly along the member length. 

Horizontal beam - left 

We double-click member 3 to open the dialog box Edit Member. 

 
Figure 4.14: Dialog box Edit Member 
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In the dialog section Cross-Section, we select a new cross-section for the Member start from the 
[Library]. 

 
Figure 4.15: Cross-Section Library 

In the Built-up dialog section, we click the button [I-Sections with Cut I-Sections, Flat Bars or  
T-Sections]. 

 
Figure 4.16: Dialog box Built-up Cross-Sections - I with Lower Vertical Flat Bar 

We select the Combination Type I-Section with Lower Vertical Flat Bar. Then, we set the Table 
IPE and select the Cross-Section IPE 360. 
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For the reinforcing sheet we enter the following parameters on the right: 

• Depth h:  300 mm 

• Thickness s: 10 mm 

After clicking the [OK] button we can see the cross-section properties displayed in the dialog 
box New Cross-Section. We also confirm the input in this dialog box and return to the initial dia-
log box Edit Member. 

We repeat the procedure for the Member end: We click the [Library] button, select the option  
[I-Sections with Cut I-Sections, Flat Bars or T-Sections] again and define the combined cross-
section I-Section with Lower Vertical Flat Bar as shown in Figure 4.16. This time, however, we en-
ter 1 mm for the depth h. RSTAB is able to calculate the taper by interpolating the cross-section 
properties between both end cross-sections. 

After confirming the input with the [OK] button the dialog box Edit Member looks as follows. 

 
Figure 4.17: Dialog box Edit Member 

We confirm the dialog box, and then we see the gusset displayed as a taper on the model. The 
cross-section's inclination in the rendered view (slightly curved) results from shifting the cen-
troid that is always located on the system line. 

Horizontal beam - right 

Now, we double-click member 6 to assign another taper. As the cross-sections are already de-
fined, we can select them from the list in the dialog box Edit Member. We set cross-section 4 for 
the Member start, for the Member end we set cross-section 3. 

 
Figure 4.18: Selecting cross-sections from the list 

We confirm the dialog box with the [OK] button, and then we click in an empty space of the 
work window to cancel the selection of member 6. 
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4.3 Connecting Members Eccentrically 
We connect the tapered members eccentrically to the columns in order to determine the addi-
tional moments due to eccentrical load introduction. Therefore, we shorten the system line by 
half of the columns' cross-section height. 

Taper - left 

We double-click the left taper (member 3). In the dialog box Edit Member, we change to the  
dialog tab Options. In the dialog section Member Eccentricity, we click the [New] button to open 
the dialog box New Member Eccentricity. 

 
Figure 4.19: Dialog box New Member Eccentricity 

In the dialog section Axial offset from adjoining members, we tick the check box for Member 
start. 

In the dialog section Absolute Offset, we could define an eccentricity ei,Z to compensate the dif-
ference of the centroidal distances. In this way, it would be possible to repair the mentioned 
"slight curve" displayed in the rendering. But we do without this definition because this eccen-
tricity has almost no influence on the results. 

After confirming all dialog boxes we can check the result with a maximized view (for example 
zooming by rolling the wheel button, moving by holding down the wheel button, rotating by 
holding down the wheel button and keeping the right mouse button pressed). 
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Figure 4.20: Eccentric connection in zoomed view 

Taper - right 

The eccentricity of the second tape is defined in the same way: We double-click member 6 and 
create a [New] member eccentricity. 

This time we tick the check box for Member end in the dialog section Axial offset from adjoining 
members. 

 
Figure 4.21: Dialog box New Member Eccentricity 

We confirm all dialog boxes with the [OK] button and check the result in the work window. 
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Changing the view 
We use the button [Isometric View] in the toolbar to set the spatial full view of the model. 

Adjusting the color assignment 
The Display navigator provides an option to display Colors According to particular criteria. 

The default setting is the display of material colors. With the option Cross-Sections we can dis-
tinguish the different cross-section types at a glance. 

 

Figure 4.22: Distinguishing cross-sections by colors 

RSTAB assigns the taper colors for each start and end cross-section to the center of the member. 

For the following input we reset the option Materials. 
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4.4 Creating Sets of Members 
Members can be combined in sets of members. In this way, it is easier to apply loads and eval-
uate results. RSTAB distinguishes between continuous members with continuously connected 
members and groups of members with arbitrarily arranged members. 

We create two continuous members, each from the horizontal beams of one roof side. To open 
the dialog box below, we select Model Data on the Insert menu, point to 1.11 Sets of Members 
and click Dialog Box. 

In the Description field, we enter Horizontal beam left and select Continuous members in 
the  Type dialog section. We use the [] button to select the horizontal beams 3 and 5 one af-
ter the other by mouse-click in the graphical work window. After confirming the selection by 
clicking the [OK] button in the Set of Members window, the dialog box looks as follows. 

 
Figure 4.23: Dialog box New Set of Members 

To complete the definition of the set of members, we click [OK]. 

We define the right set of members of horizontal beams graphically by means of the button 
[New Set of Members] (second row of toolbar, sixth button). 

The window Set of Members appears. 

 
Figure 4.24: Window Set of Members 

We click the two horizontal beams 4 and 6. After [OK], the dialog box New Set of Members  
appears where we enter the Description Horizontal beams right. The Type Continuous 
members is preset.  

We click [OK] to define the second set of members. 
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4.5 Arranging Supports 
The model is still without supports. Therefore, we select the nodes 1 and 3 by holding the left 
mouse button down and drawing a window across both nodes. The selected nodes are high-
lighted in a different color. 

 
Figure 4.25: Selecting nodes of column bases with window 

Tips for selection: 

• If you pull up the window from the left to the right, the partial view contains only objects 
that are completely within this window. If you pull up the window from the right to the left, 
the partial view additionally contains those objects that are cut by the window. 

• The selection is acting "alternatively": When you click an object (node, member, load), the 
selection of an already selected object will be canceled. Only the new object is selected. If 
you want to add the object to an existing selection, hold down the [Shift] key when clicking. 

Now, we click the button [New Nodal Support] to open the dialog box New Nodal Support. 

The Node No. 1 and 3 as well as the Hinged Type of Support are preset. 

 
Figure 4.26: New Nodal Support 

We could use the [New] button to create a user-defined support type, but we accept the 
hinged support. The three check boxes indicate the direction of the column supported in X 
and Z. A restraint about Y is not defined. 

We confirm the dialog box with [OK]. Now, the input of model data is complete. 
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4.6 Changing the Numbering 
The numbers of members and nodes got mixed up a bit because of the member divisions. It 
has no significance for the calculation. However, a clearly arranged numbering makes the in-
put and evaluation of data easier. 

RSTAB is able to correct irregular numberings automatically. First, we select all objects by 
drawing a window across the entire structure. 

Then, we point to Renumber on the Tools menu and select Automatically. The following  
dialog box opens where we specify the priorities for the numbering directions. 

 
Figure 4.27: Dialog box Renumber - Automatically 

First, we want to number the nodes and members according to X-coordinates, in ascending 
order and in direction of the positive axis X. 

The Y-axis is of no importance for our 2D example. Therefore, Axis Z is the second priority. In 
addition, we change the Direction of the numbering to Negative. Thus, RSTAB will number the 
support nodes first and then the nodes above (they lie in negative direction Z). 

After clicking the [OK] button the numbers of nodes and members are changed according to 
the specifications. 
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4.7 Checking the Input 

Checking data in navigator and tables 
All entered objects can be found in the directory tree of the Data navigator and in the tabs of 
the table. The entries in the navigator can be opened (like in Windows Explorer) by clicking the 
[+] sign. To switch between the tables, we click the individual table tabs. 

We can display and hide navigator and tables by selecting Navigator or Table on the View 
menu. We can also use the corresponding toolbar buttons. 

In the tables, structural objects are organized in numerous tabs. Graphics and tables are inter-
active: To find an object in the table, for example a member, we set table 1.7 Members and se-
lect the member in the work window by clicking. We see that the corresponding table row is 
highlighted. 

 
Figure 4.28: Model in isometric view with navigator and table entries 

Changing the model display 
The frame is displayed as transparent model by default. We can use the list button shown on 
the left to set other options for visualization: 

• Wireframe display model 

• Solid display model 

• Solid transparent display model 

When complex structural systems are modeled, the wireframe setting allows for a clear over-
view. 

Saving data 
Finally, the input of model data is complete. To save our file, 

we select Save on the File menu 

or use the toolbar button shown on the left. 

Saving data in the demo version is not possible. 
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5.  Loads 
The Data navigator contains the following entries in the folder Load Cases and Combinations: 

• Load cases 
• Actions 
• Combination expressions 
• Action combinations 
• Load combinations 
• Result combinations 
• Super combinations 

We define the actual loading such as self weight, snow and wind load in the load cases. Then, 
the load cases are organized in actions and superimposed with partial safety factors according 
to the standard's combination expressions (see chapter 6). 

5.1 Load Case 1: Self-weight 
The first load case contains the permanently acting loads from self-weight and roof structure. 

We use the button [New Member Load] to create a load case. 

 
Figure 5.1: Button New Member Load 

The dialog box Edit Load Cases and Combinations appears. 

 
Figure 5.2: Dialog box Edit Load Cases and Combinations, tab Load Cases 
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Load case no. 1 is preset with the action type Permanent. For the Load Case Description we  
enter Self-weight, or we choose the entry from the list. 

5.1.1 Self-weight 
The Self-Weight of all members in direction Z is automatically taken into account when the  
factor Active is specified with 1.000 as already preset. 

5.1.2 Roof Structure 
We confirm the input by clicking the [OK] button. The dialog box New Member Load opens. 

The self-weight of the roof structure acts as load type Force. The load distribution is Uniform. 
We accept these presettings as well as the load direction in Global Z and the True member 
length as reference length. 

In the dialog section Load Parameters, we enter the value 1.5 kN/m (see chapter 2.3, page 6). 
Then, we close the dialog box by clicking [OK]. 

 
Figure 5.3: Dialog box New Member Load 

Now, we can assign the load graphically to the horizontal beams: We can see that a small load 
symbol has appeared next to the pointer. This symbol disappears as soon as we move the 
pointer across a member. We click the members 2, 3, 4 and 5 one after the other to put the 
loads on the horizontal beams (see Figure 5.4). 

We can hide and display the load values with the toolbar button [Show Load Values]. 

To quit the input mode, we use the [Esc] key. We can also right-click into the empty work  
window. 

The input of the load case Self-weight is complete. 
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Figure 5.4: Assigning roof loads graphically 

5.2 Load Case 2: Snow 
Before we enter the snow load, we create a new load case. To open the corresponding dialog 
box, 

we point to Load Cases and Combinations on the Insert menu and select Load Case, 

or we use the corresponding button in the toolbar (to the left of the load case list). 

 
Figure 5.5: Dialog box Edit Load Cases and Combinations, tab Load Cases 

As Load Case Description we select the entry Snow from the list. 

We set the Action Type to Qs Snow (H ≤ 1000 m a.s.l.) and confirm the input with [OK]. 
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We choose a new way to enter the member loads: We select all horizontal frame beams 
(members 2 to 5) by drawing a selection window from the left to the right over this area. Now, 
when we open the dialog box by means of the button [New Member Load], we can see that 
the numbers of the selected members are already entered. 

The load type is preset to Force. The load distribution is set to Uniform with the load direction 
Global Z. In contrast to dead loads which refer to the true area, snow loads must refer to the 
base area, and therefore we change the Reference Length to Projection in Z. 

 
Figure 5.6: Dialog box New Member Load 

In the dialog section Load Parameters, we enter the value 3.4 kN/m (see chapter 2.3, page 6). 
Then, we close the dialog box by clicking [OK]. 

 
Figure 5.7: Snow load 
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5.3 Load Case 3: Wind 
We put the wind load for wind zone 1 and terrain category III only on the two columns to sim-
plify our example. The roof areas are neglected. 

We create a [New Load Case] for the wind loads in direction X. 

In the dialog field Load Case Description, we select Wind in +X from the list. The Action Type 
changes automatically to Qw Wind. 

 
Figure 5.8: Dialog box Edit Load Cases and Combinations 

We click [OK], and then we select the two column members 1 and 6 by mouse-click. When 
clicking we hold down the [Ctrl] key, as common for Windows applications, to do a multiple  
selection. 

With a click on the button [New Member Load] we open the dialog box shown in Figure 5.9. 

The load is acting as a Force. The load diagram is Uniform. We set the load direction to Global X. 
Again we select the True member length as the Reference Length. 

In the dialog section Load Parameters, we enter 2.0 kN/m. This is the wind load component 
that acts on the left column (see chapter 2.3, page 6). Later, we will adjust the wind suction 
value on the right column. 

We click [OK]. The member loads are displayed on the columns. 
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Figure 5.9: Dialog box New Member Load 

Now, we have to correct the wind load of the right column. We double-click the load in the 
work window. 

The dialog box Edit Member Load opens and we change the load value to 1.25 kN/m. 

 
Figure 5.10: Adjusting the load value in the dialog box Edit Member Load 

We click [OK]. The wind loads are displayed as follows. 

 
Figure 5.11: Wind loads for compression and suction 
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5.4 Load Case 4: Imperfection 
In the final load case we define imperfections for the columns and horizontal beams. 

This time, we use the Data navigator to create a new load case: We right-click the entry Load 
Cases to open the context menu, and then we select New Load Case. 

 
Figure 5.12: Context menu Load Cases 

We choose Imperfection towards +X from the Load Case Description list. The Action Type 
changes automatically to Imp Imperfection. 

 
Figure 5.13: Dialog box Edit Load Cases and Combinations 

We close the dialog box by clicking the [OK] button. 
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5.4.1 Column Members 
Member 6 is still selected. We cancel the selection by clicking with the left mouse button into 
an “empty” space of the work window. 

Now we use the button [New Imperfection] to open the dialog box New Imperfection. 

 
Figure 5.14: Dialog box New Imperfection 

In our planar structural system, we can apply the imperfection only in Direction of the member 
axis z. 

We do not change the preset Inclination 1/ϕ0 of 200, but we modify the value of the Precamber 
L/e0 to 200 (see chapter 2.3, page 6). 

Then, we set the activity criterion for the precamber by selecting EN 1993-1-1 (5.8) from the 
list. 

We confirm the input with [OK] and click the column members 1 and 6 to assign the imperfec-
tions. 

 
Figure 5.15: Assigning imperfections to columns 

We quit the function with the [Esc] key or a right-click into the work window. 
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5.4.2 Continuous Members with Horizontal Beams 
For the horizontal beams we must apply a "continuous" imperfection across both members on 
each side. This time we select the objects first. Then we assign the imperfections. 

As selecting continuous members graphically in the rendering is not that easy, 

we select Select on the Edit menu, and then we click Special, 

or we use the toolbar button shown on the left. 

In the dialog box Special Selection, we set the category Sets of Members on the left. As we want 
to select All sets of members, we can confirm the dialog box directly with the [OK] button. 

 
Figure 5.16: Dialog box Special Selection 

Again we use the button [New Imperfection] to open the dialog box New Imperfection. 

 
Figure 5.17: Dialog box New Imperfection 
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The numbers of both sets of members are preset. 

We set the Inclination 1/φ0 to 0 and change the value of the Precamber L/e0 to 250 (see chapter 
2.3, page 6). 

After clicking the [OK] button we can see the imperfections displayed in the model. 

The direction of inclination and precamber on the right beam does not yet fulfill the specifi-
cations (see Figure 2.1, page 5). We double-click this imperfection to open the dialog box Edit 
Imperfection. 

 
Figure 5.18: Adjusting the orientation of inclination and precamber 

We put a negative sign [-] in front of the value for precamber. Consequently, the imperfection 
is acting in direction of the negative member axis z. 

When we click [OK] we can see that the imperfections are displayed correctly. 

 
Figure 5.19: Imperfections for columns and horizontal beams 
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5.5 Checking Load Cases 
All four load cases have been completely entered. It is recommended to [Save] the input now.  

We can check each load case quickly in the graphics: The buttons [] and [] in the toolbar  
allow us to select previous and subsequent load cases. 

 
Figure 5.20: Browsing the load cases 

The loading's graphical input is also reflected in both the Data navigator tree and the tables. 
We can access the load data in table 3. Loads which can be set with the button shown on the 
left. 

Again, graphic and tables are interactive: To find a load in the table, for example a member 
load, we set table 3.2 Member Loads, and then we select the load in the work window. We see 
that the pointer jumps into the corresponding row of the table.  

 
Figure 5.21: Interaction between graphic and load tables 
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6.  Combination of Actions 
We combine the load cases according to EN 1990. We take advantage of the generator inte-
grated in the program to superimpose the actions with the required partial safety factors and 
combination coefficients. The relevant conditions have already been created when the model 
was defined in the dialog box General Data where we have chosen the option Create combina-
tions automatically (see Figure 3.1, page 7). 

The Action Type defined for the load cases (see Figure 5.13, page 32) determines the way how 
load cases are combined in different design situations. 

6.1  Checking the Actions 
The load cases must be assigned to Actions which will be superimposed in accordance with 
regulations. Actions represent independent influence values that arise from different origins. 

The load cases, actions and combinations are managed in the dialog box Edit Load Cases and 
Combinations (see Figure 5.13, page 32) as well as in tables number 2. We can access these  
tables by clicking the table button shown on the left. Table 2.1 Load Cases shows us the four 
load cases with the selected action categories in a clear overview. 

 
Figure 6.1: Table 2.1 Load Cases  

The subsequent table 2.2 Actions shows us the load cases that are contained in the individual 
actions. Each load case of our example is assigned to another action. However, if we had de-
fined, for example in a spatial model, several wind load cases for different directions, they all 
would be listed in the action Wind. 

 
Figure 6.2: Table 2.2 Actions 

The imperfections are missing in this table because they do not represent "real" actions. 
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6.2 Defining Combination Expressions 
In accordance with EN 1990, we have to combine the actions for the ultimate and the service-
ability limit state design according to certain rules. Table 2.3 Combination Expressions shows us 
which limit states are set to be analyzed. 

 
Figure 6.3: Table 2.3 Combination Expressions 

Only the ultimate limit state (ULS) is relevant for our example. Therefore, we remove the three 
check marks in the table column Use for the combination rules of the serviceability limit states 
(SLS). 

We right-click table entry CE1 (in the first table column). The context menu opens where we 
select the entry Edit via Dialog Box. 

 
Figure 6.4: Context menu of table row 

The dialog box Edit Load Cases and Combinations appears (see figure below). In the dialog tab 
Combination Expressions, we can adjust the settings according to which the combinations are 
created. 
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Figure 6.5: Dialog box Edit Load Cases and Combinations, tab Combination Expressions 

In the dialog section Settings, we activate the option Imperfection load cases to Consider the 
imperfections for the generation of combinations. When we tick the check box, the following 
dialog box opens. 

 
Figure 6.6: Dialog box Settings for imperfection load cases 

We set the check marks as shown in the figure above. Then, we confirm the data with [OK]. 
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In the dialog box Edit Load Cases and Combinations (see Figure 6.5), we make sure that the  
option Generate additionally Either/Or result combination is checked as well. This combi-
nation provides the extreme values from the results of all load combinations (envelope). 

Then we confirm the dialog box with [OK]. 

6.3 Creating Action Combinations 
When we move on to the next table 2.4 Action Combinations, RSTAB creates five combinations 
which are listed and sorted by actions. 

 
Figure 6.7: Table 2.4 Action Combinations 

This overview corresponds to the presentation of actions described in the standards. Looking 
at the Use column we can see which action combinations will be considered for the generation 
of load combinations. 

6.4 Creating Load Combinations 
Five load combinations are automatically created from the five action combinations. The result 
is listed in the subsequent table 2.5 Load Combinations. 

 
Figure 6.8: Table 2.5 Load Combinations 

Table columns D to K inform us about the load cases including partial safety and combination 
factors that are taken into account for each load combination. 

The imperfections are contained in all combinations as specified before (see Figure 6.6). 

To open the dialog box Edit Load Cases and Combinations, we use the context menu of the  
table row (see Figure 6.4, page 38), or  

we point to Load Cases and Combinations on the Edit menu, and then we click Load 
Combinations, 

to look at the created load combinations. 
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Figure 6.9: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

When we select the Existing Load Combinations one after the other in the list, we can see all 
load cases together with the respective partial safety and combination factors displayed in the 
dialog section to the right. Load cases which act as Leading within the combination are identi-
fied by a check mark. 

Furthermore, we can use the tab Calculation Parameters to check the specifications applied by 
RSTAB for the calculation of different load combinations. 

 
Figure 6.10: Checking the Calculation Parameters of a load combination 

Basically, load combinations are analyzed non-linearly according to the Method of Analysis for 
Second-order analysis. Thus, it is possible to take into account influences from structural de-
formation resulting in an increase of internal forces. 



6  Combination of Actions 

 

 
Dlubal 

42 RSTAB Introductory Example © 2014 Dlubal Software GmbH 

6.5 Checking Result Combinations 
When we defined the combination expressions, we activated the option Generate additionally 
Either/Or result combination (see Figure 6.5, page 39) giving us information about the extreme 
values of all load combinations. 

RSTAB generates a results envelope from the load combinations. The definition criterion can 
be checked in the final tab of the dialog box Edit Load Cases and Combinations as well as in  
table 2.6 Result Combinations. 

 
Figure 6.11: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

All load combinations are superimposed with the factor 1.00 and the criterion Permanent.  
They are all assigned to group 1, which means that they act alternatively. 

Now, the superposition criteria is completely defined. We can save the input with the [Save] 
button.   
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7.  Calculation 
 

7.1 Checking Input Data 
Before we calculate our structure, we want RSTAB to check our input. To open the correspond-
ing dialog box, 

we select Plausibility Check on the Tools menu. 

The dialog box Plausibility Check opens where we define the following settings. 

 
Figure 7.1: Dialog box Plausibility Check 

If no error is detected after clicking [OK], a corresponding message is displayed, including 
summary of model and load data. 

7.2 Calculate Model 
To start the calculation, 

we select Calculate All on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.2: Calculation process 
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8.  Results 
 

8.1 Graphical Results 
As soon as the calculation is finished, RSTAB displays the deformations of the load case that is 
currently set. The last load setting was RC1, so now we see the maximum and minimum results 
of this result combination. 

 
Figure 8.1: Graphic of deformations for result combination RC1 

Selecting load cases and load combinations 
We can use the toolbar buttons [] and [] (to the right of the load case list) to change among 
the results of load cases, load combinations and result combinations. We already know those 
buttons from checking the load cases. It is also possible to select a specific load case or combi-
nation in the list. 

 
Figure 8.2: Load case list in the toolbar 
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Selecting results in the navigator 
A new navigator has appeared, managing all result categories for the graphical display. We can 
access the Results navigator when the results display is active. We can switch the results display 
on and off in the Display navigator, but we can also use the toolbar button [Show Results] 
shown on the left. 

 

Figure 8.3: Results navigator 

Now, we can browse the single load cases. By selecting the different results categories we see 
deformations, internal forces and support reactions displayed in RSTAB. 

In the figure above, we see the member internal forces My and the support reactions Px' and Pz' 
calculated for CO5. To display the forces, it is recommended to use the wireframe model. We 
can set this display option with the button shown on the left. 

Show deformations as animation 
The deformation of the model cannot be represented only in its final state but as motion se-
quence. First, in the Results navigator, we set the results category Global Deformations. We 
can also use the toolbar button shown on the left. 

Then, we click the button [Animation] to display the deformation process for all steps between 
initial state and final deformation. To close the animated view, we click the button again. 
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8.2 Results Tables 
We can evaluate results also in tables. 

The results tables are displayed automatically after the calculation. There are different tables 
for the results, too. Table 4.0 Results - Summary offers us a summary of the calculation process, 
sorted by load cases and load combinations. 

 
Figure 8.4: Table 4.0 Results - Summary 

To select other tables, we click their table tabs. To find specific results in the table, for example 
the internal forces of a horizontal beam, we set table 4.1 Members - Internal Forces. When we 
click the member in the graphic, we can see that the pointer jumps to the corresponding in-
ternal forces in the table. The current member location x, that means the position of the point-
er in the table row, is indicated by a marking arrow in the graphic. 

 
Figure 8.5: Internal forces in table 4.1 and indication of current location x on the model 

Similar to the function in the main toolbar we can use the buttons [] and [] to  browse the 
load cases. We can also use the list in the table toolbar to set a particular load case. 
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8.3 Filter Results 
RSTAB offers us different ways and tools by which we can represent and evaluate results in 
clearly-structured overviews. We can use these tools also for our example. 

8.3.1 Visibilities 
Partial views and cutouts can be used as so-called Visibilities in order to evaluate results. In our 
example, we set the [Solid Transparent Display Model] and display the internal forces My again. 

Show results of columns 
We click the tab Views in the navigator. We select Members by Cross-Section listed under the visi-
bilities that RSTAB has generated from the entered data. In addition, we tick the entry HE A 300. 

 

Figure 8.6: Moments My of columns in scaled representation 

The display shows the two columns including results. The remaining model is displayed only in 
gray and without results. 

Adjusting the scaling factor 
In order to check the diagram of internal forces on the rendered model without difficulty, we 
scale the data display in the control tab of the panel. We change the factor for Member diagrams 
to 2 (see figure above). 
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Show results of a continuous member 
In the same way, we can filter the results of the continuous members in the View navigator. We 
clear the check box for Members by Cross-Section and select the entry Sets of Members where 
we tick the set of members No. 2. 

 

Figure 8.7: Moments My of right continuous member 

As already described, we can change the display of result categories in the Results navigator 
(see Figure 8.3, page 45). The figure above shows the moment diagram of the right horizontal 
beam determined for CO5. 
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8.3.2 Results on Objects 
Another possibility to filter results is using the filter tab of the control panel where we can 
specify numbers of particular members to display their results exclusively. In contrast to the 
visibility function, the model will be displayed completely in the graphic. 

First, we deactivate the option User-defined/generated in the Views navigator. 

 
Figure 8.8: Resetting the overall view in the Views navigator 

We select member 6 (right column) by mouse click. Then, in the panel, we change to the filter 
tab. 

We click the button [Import from Selection] and see that the number of the selected member 
has been entered into the input field above. Now, the graphic shows only the results of the 
right column. 

 

Figure 8.9: Displaying the member moments of the right column 

We use the panel option All to reset the full display of results. 
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Context menu for set of members 

 

8.4 Display of Result Diagrams 
Another way to evaluate member results is the diagram. Now, we use this function to look at 
the result diagram of the left continuous member. 

The graphical selection of continuous members is easier when the [Wireframe Display Model] 
is set. 

We right-click the set of members 1 and select the entry Result Diagrams in the context menu. 

A new window opens displaying the result diagrams of the left horizontal beam. 

 
Figure 8.10: Result diagrams of left horizontal beam 

In the navigator, we tick the check boxes for the global deformations u and the internal forces 
N and My. 

To adjust the size of the displayed result diagrams, we use the buttons [+] and [-]. 

The buttons [] and [] for load case selection are also available in the result diagram window. 
But we can also use the list to set the results of a load case. The same buttons are provided for 
the Sets of members selection in the upper left corner of the window: We click them to switch 
between both continuous members. 

We quit the function Result Diagrams by closing the window. 
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9. Documentation 
 

9.1 Creation of Printout Report 
It is not recommended to send input and output data directly to the printer. Therefore, RSTAB 
prepares data in a print preview, we call it "printout report". We use the report to determine 
the data that we want to include in the printout. Moreover, we can add graphics, descriptions 
or scans. 

To open the printout report, 

we select Open Printout Report on the File menu 

or we use the button shown on the left. A dialog box appears where we can specify a Template 
as sample for the new printout report. 

 
Figure 9.1: Dialog box New Printout Report 

We accept template 1 - Input data and reduced results and generate the print preview with [OK]. 

 
Figure 9.2: Print preview in printout report 
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9.2 Adjusting the Printout Report 
Also the printout report has a navigator, listing the selected chapters. By right-clicking a navi-
gator entry we can see its contents in the window to the right. 

The preset contents can be specified in detail. To adjust the output of the internal forces, we 
right-click chapter Results - Result Combinations. Then we click Selection in the context menu. 

 
Figure 9.3: Context menu Results - Result Combinations 

In the dialog box Printout Report Selection, we make sure that table row 4.1 Members - Internal 
Forces is checked. Then we place the pointer into the table cell to the right. The button [...]  
becomes available which opens the dialog box Details - Internal Forces by Member. 

 
Figure 9.4: Integration of member internal forces in Printout Report Selection 

We check if only the Extreme values of the internal forces are activated for the printout. 

After confirming the dialog boxes, RSTAB adjusts the output of internal forces according to our 
settings. 
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Figure 9.5: Extreme values of member internal forces in printout report 

In the same way, we can adjust all remaining chapters for the printout. 

To change the position of a chapter within the printout report, we move it to the new naviga-
tor position by using the drag-and-drop function. When we want to delete a chapter, we use 
the context menu (see Figure 9.3) or the [Del] key on the keyboard. 

9.3 Inserting Graphics in Printout Report 
Often, we integrate graphics in the printout to illustrate the documentation. 

Printing graphics of internal forces 
We close the printout report with the [X] button. The program asks us Do you want to save the 
printout report? We confirm this query and return to the work window of RSTAB. 

In the work window, we set the Results and select the moments My for CO5. Then, we put the 
graphic in an appropriate position. 

 
Figure 9.6: Moment diagram of CO5 
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Now, we transfer this graphical representation to the printout report. 

We select Print Graphic on the File menu 

or use the toolbar button shown on the left. 

We set the following print parameters in the dialog box Graphic Printout. It is not necessary to 
change the default settings in the tab Options. 

 
Figure 9.7: Dialog box Graphic Printout 

We click [OK] to print the results graphic into the printout report. 

The graphic appears at the end of chapter Results - Load Cases, Load Combinations. 

 
Figure 9.8: Graphical moment diagram in printout report 
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Printing the printout report 
When the printout report is completely prepared, we can send it to the printer by using the 
[Print] button. 

The PDF print device integrated in RSTAB makes it possible to put out report data as PDF file. 
To activate the function, 

we select Export to PDF on the File menu. 

In the Windows dialog box Save As, we enter file name and storage location. 

By clicking the [Save] button we create a PDF file with bookmarks facilitating the navigation in 
the digital document. 

 
Figure 9.9: Printout report as PDF file with bookmarks 
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10.  Outlook 
Now, we have reached the end of the introductory example. We hope that this short introduc-
tion helps you to get started with RSTAB and makes you curious to discover more of the pro-
gram functions. You find the detail program description in the RSTAB manual that you can 
download on our website at www.dlubal.com/downloading-manuals.aspx. 

With the Help menu or the [F1] key it is possible to open the program's online help system 
where you can search for particular terms like in the manual. The help system is based on the 
RSTAB manual. 

Finally, if you have any questions, you are welcome to use our free e-mail hotline or to have a 
look at the FAQ page at www.dlubal.com or on our DLUBAL blogs at www.dlubal.com/blog. 

Note: This example can be carried out in the add-on modules for the design results (for exam-
ple STEEL, STEEL EC3, RSBUCK). In this way, you will be able to perform the design, getting an 
insight into the functionality of the add-on modules. Then, you can also evaluate the design 
results in the RSTAB work window. 

 

 

 

 

http://www.dlubal.com/downloading-manuals.aspx
http://www.dlubal.com/
http://www.dlubal.com/blog/en/
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